
Revit FAQ:  

 
Q1. Can you save a file created in Revit Architecture 2010 to an earlier 
version and open it in that earlier version?  
A1. No! Revit has no means of saving its project file from any release back 
to early releases. So Revit Architecture 2010 cannot be saved back or 
opened by Revit Architecture 2009, or earlier. There is simply no backward 
compatibility. This is because as Revit building elements and components 
are enhanced with new features and new commands that allow 
improvements in Revit elements and components linking and constraint 
relationships there is no way to support it in a prior release that did not 
support the same parametric relationships. That is why it is critical for Revit 
users to be on subscription and maintain the latest release or make sure 
that any work they do and any consultants involved using Revit MEP or 
Revit Structure must be using the same release.  

  

Q2. How do you export a Revit drawing to AutoCAD?  
A2. In Revit, pull down the big R in the upper left corner of the screen, then 
Export, CAD Formats, DWG, then click the "Export" button at the bottom of 
the "Export CAD Formats" dialogue box, and browse to folder you want to 
save it to. The default CAD type is an AutoCAD 2010 DWG file, although 
you can also save to 207, 2004 or 2000 versions of AutoCAD. You can also 
export to a DXF file, to a DGN (Bently Systems Microstation format), or 
ACIS SAT format (this is a 3D object-oriented software modeling kernal 
developed by Alan Grayer, Charles Lang and Ian Braid as part of Three-
Space Ltd., and sold by them to current owner, Spatial Corporation); SAT is 
an acronym for "Standard ACIS Text." You can rename the file name as 
you save it. If you have one of the plans, sections or elevations selected at 
time of export, the plan (complete with all tags and callouts) will be 
converted to a 2D drawing in AutoCAD. If you have a 3D view selected, the 
AutoCAD drawing will also be 3D and Revit entities will be converted to 
"polyline meshes" in AutoCAD. These can be exploded several times down 
to lines, arcs and circles, but will lose their 3D appearance. The most useful 
way of bringing your Revit drawings into AutoCAD is to bring in the plans 
and elevations separately.  

  



Q3. How do you import an AutoCAD plan or elevation drawing into Revit?  
A3. In Revit, click the Insert tab, select the "Import CAD" icon, and browse 
for the file that you want to import. Before you import the drawing, in 
AutoCAD do the following:  

1. If you are using Architectural Desktop or AutoCAD Architecture 2009 
or 2010, set the variable "proxygraphics" to 1 (it is 0 by default). To 
do this, simply type proxygraphics at the Command: line and then 1. 
This will allow walls, doors and windows in plan to be imported. 
 

2. I recommend freezing all layers which contain notes and dimensions. 
These do not translate well into Revit and it is easier to redo them in 
Revit itself.  

The AutoCAD drawing comes in to Revit as a 2D drawing even if it is 3D in 
AutoCAD, so you will need to retrace walls in Revit and insert doors and 
windows into the Revit drawing after importing. The drawing comes in as a 
"block" in Revit, so if you want to move anything in the imported AutoCAD 
drawing in Revit you have to explode the AutoCAD imported drawing. To 
do this, select the AutoCAD imported drawing after importing it, right click 
and then select "Partial Explode." "Full Explode" is not necessary unless 
you want all the AutoCAD blocks and Xrefs to be exploded as well. It is a 
mess. Because it is a mess, I recommend that you only use the imported 
AutoCAD drawing as a guide to trace over into Revit. Better yet, instead of 
importing an AutoCAD drawing and tracing over it, Link it in and then get rid 
of the link later. To Link an AutoCAD drawing, click the Insert tab, select the 
"Link CAD" icon, then browse for the file to link. Later, after you are done 
tracing it, you can remove the link by selecting "Manage Links" under the 
Insert tab. In the "Manage Links" dialogue box that appears, click on the file 
you want to remove and select the "Remove" button. 

  

Q4. How can you bring AutoCAD details into a Revit drawing?  
A4. "Drafting Views" in Revit are meant to contain details that you either 
draw using the line arc and circle commands in Revit or insert already 
existing AutoCAD 2D details. To create a Drafting View in Revit, click the 
View tab, select "Drafting View." The "New Drafting View" dialogue box will 
appear. You can give the drafting view a name and set a scale. This will 
create a blank page onto which you may import any AutoCad detail you 



have. To import an AutoCAD drawing, click the Insert tab, select the 
"Import CAD" icon, and browse for the file that you want to import. 

You can import any .DWG, .DXF, .DGN (Microstation), ACIS .SAT, or .SKP 
(Sketchup) files. Navigate to where the file is stored and select it. You can 
put as many drawings on the Drafting View as you want, however, each 
Drafting View will only get one label on the sheet you place it on. To get the 
detail onto a sheet, open a sheet and drag the drafting view onto it.  

The list of Drafting Views will show up in the Browser after Sections.  

Each Drafting View is given a detail number automatically by Revit.  
 
Click on this link to watch a video that shows how to do this: 
http://www.avatech.com/training/online/action.aspx?mid=287 

Although this tutorial was written for Revit 2008, the principles are the same 
for 2010. 

  

Q5. How do you create a drawing index?  
A5. To create a drawing list:  

1. Click View (pulldown) menu > New > Drawing List.  
2. Select the Fields to appear in the drawing list. Some typical fields 

include Sheet Number, Sheet Name, Checked By, Drawn By, and 
Sheet Issue Date.  

3. To create user-defined fields, click Add Parameter.  
4. Specify the Fields, Filter, Sorting/Grouping, Formatting, and 

Appearance options within each tab.  
5. Click OK.  
6. Drag the drawing List onto a sheet.  

  

Q6. How do you hide and unhide objects in Revit?  
A6. There are three methods: 

Method No. 1: To hide an object "temporarily" (until you print or close the 
drawing) left click the object to select it and select the “Temporary 



Hide/Isolate” icon in the View Control Bar at the bottom of the screen (the 
one that looks like sun glasses), then select “Hide Element.”  

To unhide an object that has been "temporarily" hidden: Select the 
“Temporary Hide/Isolate” icon in the view control bar at the bottom of the 
screen, then select “Reset Temporary Hide/Isolate.” Note that this will work 
as long as the temporary Hide/Isolate has not been made permanent (that 
is, there is a blue line around the view and the “Temporary Hide/Isolate” 
icon is blue). If it is not, then you will have to use the method in step one 
above.  

Method No. 2: To hide an object "permanently" (until you unhide it) in one 
view only click on the object to be hidden - it will turn it red. If you want to 
hide all objects of the same type, such as all of the same design of walls or 
doors or windows), right click and select "Select All Instances." Right click 
again and select "Hide in View>" "Elements." Or you may also select 
"Category" instead of "Elements" if you mean to hide all walls, doors, or 
windows, for example. 

To unhide an object that has been "permanently" hidden click on the 
“Reveal Hidden Elements” light bulb in the View Control Bar at the bottom 
of the screen; change the “Model Graphics Style” in the view control bar at 
the bottom of the screen to “Wireframe” (because another element might 
be covering and hiding the hidden element); any and all hidden elements 
will appear as colored lines; right click the element to be “unhidden;” select 
“Unhide in view” and “”Elements;” turn the light bulb in the view control bar 
off by clicking on it.  

Method No. 3: To hide all objects of the same type (such as walls, doors or 
beams) "permanently" (until you unhide them) use the “Visibility/Graphics 
override” (type VV or VG) and uncheck the "Walls" or "Doors" or “Framing” 
box. Note that when you use this method to hide elements, you cannot use 
the “Reveal Hidden Elements” light bulb in the view control bar at the 
bottom of the screen to turn them back on. You will have to go back to VV 
and check the box to turn the category of elements on.  
 
Note that all hiding and unhiding of all sorts are view-specific.  

  

 



Q7. How can you make beams and bar joists be visible in Reflected Ceiling 
Plan?  
A7. For some unknown reason, the programmers of Revit decided to hide 
beams and bar joists in Reflected Ceiling Plans, even if there is no ceiling. 
To make steel beams and bar joists visible in a Reflected Ceiling Plan, go 
to the Reflected Ceiling Plan in which the beams and bar joists should 
appear. For very high ceilings you will need to change the view range to the 
level above. To do this, in the Reflected Ceiling Plan, right-click in the 
drawing area, select "View Properties" (or type VP) select the "Edit" button 
to the right of "View Range." Make sure that the "Primary Range" is set to 
the Level Above, and that the View Depth is set to the Level Above. Click 
OK, then OK. Now click on the “Reveal Hidden Elements” light bulb in the 
view control bar at the bottom of the screen. The beams and bar joists will 
appear as magenta colored lines. Hover the mouse cursor above one of 
the joists, right click and select “Unhide in View” then “Category.”  
To show the actual width of the beam or bar joist, change the “Detail 
Level:” in the view control bar at the bottom of the screen to “Fine.”  
Note that all hiding and unhiding is view-specific.  

  

Q8. How can you make structural elements (beams and bar joists) visible in 
a floor or roof plan view?  
A9. Bring up the floor or roof plan view in which you want to make the 
structural framing visible. Right-click in the drawing area, select "View 
Properties" (or type VP). Under the Graphics section, the Discipline 
normally listed is "Architecture." Select the drop-down box to the right of the 
word "Architectural" and select "Structural." All framing will be shown 
dashed in the structural discipline.  

  

Q9. How can you borrow a Titleblock sheet to use in a new drawing from 
another drawing you have?  
A9. Open the drawing with the Titleblock. In the browser, go to "Families," 
"Annotation Symbols," "Triton_D_sized_titleblock," then click on the 
"Triton_D_sized_tttleblock." Right click and select "Copy to Clipboard." 
Open a new Revit drawing. Type <Ctrl>V (this means "paste from 
clipboard" and is the same as if you selected from the Edit pull-down menu, 
then "Paste from Clipboard"). Now you will have that titleblock available to 
use in the new drawing.  



  

Q10. How can you apply a gravel hatch pattern to areas of gravel (such as 
subfill material under a slab on grade), if Revit does not have it?  
A10.  

 To quickly load an AutoCAD hatch pattern into Revit® 

1. In AutoCAD, draw a rectangle or a circle.  
2. Hatch the rectangle with the hatch pattern you want to load into Revit, 

and then adjust the scale accordingly.  
3. Save the drawing.  
4. Import the drawing into Revit.  
5. Explode the drawing. 

The hatch pattern should now be listed in your fill patterns. 

You can import AutoCAD hatch patterns. Select the "Settings" pull-down 
menu, then "Fill Patterns" then "New." This will bring up the "New Pattern" 
dialogue box. Select the "Custom" radio button. Under Name, type in 
Gravel. Under the custom area, select the "Import" button. This will allow 
you to open the AutoCAD hatch pattern file. To find this file, navigate to My 
Computer, Local Disk C:, Documents and Settings, AT150, Application 
Data, Autodesk, Autocad2008, enu, Support. The acad.pat file will be found 
there. Double click it. Scroll down the list of patterns that appears, you will 
find "Gravel" in this list. Select it. Set the Import scale to 0.05. Click OK, 
then OK again. Now Gravel hatch will be available for you to use in your 
drawing. If you want to make this permanent so you do not have to do it 
again in a future drawing, save the drawing as a Template file. To use the 
gravel pattern, right-click on the element you want to apply the pattern to. 
Click Element Properties. Click Edit/New to bring up the Type Properties 
dialogue box. Under the Construction heading select the Edit button to the 
right of "Structure." Click on the material in the dialogue box that appears. 
Click on any material, and click the "Duplicate" button. Give the material a 
name, such as "Gravel." Click OK. Click the button to the right of the "Cut 
Pattern" (the so-called "dot . dot . dot . " or ellipsis button). This will bring up 
the familiar "Fill Patterns" dialogue box. Select the gravel pattern that you 
just created from there. Click OK, OK, OK, OK, OK. Now you should see 
the new gravel pattern in your material. If you do not, you have the "Detail 
Level: in the view control bar at the bottom of the drawing window set to 
Coarse. Change it to Fine.  



  

Q11. How can you change a solid (continuous) line to a dashed line?  
A11. There are two ways to do this: 

1. In the view in which you want an object changed to dashed lines type 
VV. This will bring up the "Visibility/Graphics Overrides" dialogue box. The 
column on the left lists all elements in the drawing. Select the element you 
want to change. In the second column from the left select the "Override" 
button. Pull down the drop-down list of line types under "Pattern" and select 
the "Dash" linetype, for example. This method will change the linetype to 
dashed for all objects of that type. 

2. Select the "Linework" tool (looks like a fountain pen nib), select the type 
of line you want to turn the object into on the dropdown linetype list on the 
left (such as "Hidden line"), then slect the line of the object you want to 
change. 

  

Q12. How can I show the footprint of a plan in the site plan when it is 
hidden below a roof overhang? 
A12. Change the Model Graphics Style to "Wireframe" on the View Control 
Bar at the bottom of the screen. Select the Drafting tab, then "Detail Lines." 
Change the linetype to "Hidden Lines." Using the line tool, trace around the 
exterior face of the exterior walls. Change back the Model Graphics Style to 
"Hidden Lines" on the View Control Bar at the bottom of the screen. The 
dashed drafting lines will show through the roof. Be careful though, 
because if the location of the walls change, the drafting lines will not follow 
the change. 

  

Q13. What is the difference between "Duplicate," "Duplicate with Detailing," 
and "Duplicate as a Dependent?"  
A13. There are several subtle, but important differences among these three 
types of view duplication, as follows:  
 
"Duplicate" only duplicates the geometry, which are objects such as walls, 
windows, doors and components, but not annotation such as text or 
dimensions. As the original (parent) model changes in geometry, the 
"Duplicate" view will automatically be updated. Changes made to the 



geometry of the Duplicate will be reflected back to the original (parent) 
view. Additions of annotations to the Duplicate will not be reflected back to 
the original (parent) view. This is used to allow users to have certain items 
turned on, such as furniture, in the Duplicate view, and it also allows two 
copies of the same view to be placed on the the same Sheet in the set or 
another Sheet in the set (Revit prevents placement of the same view in a 
Sheet in a Project). Different annotation can be placed in the Duplicate 
view from the original.  
 
"Duplicate with Detailing" duplicates geometry and annotations. As the 
original (parent) model changes in geometry, the Duplicate will 
automatically be updated but annotations will not. Changes made to the 
geometry of the Duplicate will be reflected back to the original (parent) 
view. Additions of annotations to the Duplicate will not be reflected back to 
the original (parent) view so it is basically a one-way technique. This is 
used to allow users to have certain items turned on, such as furniture or 
annotation, in the Duplicate view, and it also allows two copies of the same 
view to be placed on the the same Sheet in the set or another Sheet in the 
set (Revit prevents placement of the same view in a Sheet in a Project). 
Different annotation can be placed in the Duplicate view from the original.  
 
"Duplicate as a Dependent" duplicates geometry and annotations. There is 
a two-way change in this situation - whatever is changed in the original 
(parent) model will be changed in the Duplicate and vice-versa. This is 
used for large projects which will not fit on one sheet, so two copies of the 
plan can be inserted on two separate sheets using matchlines. You cannot 
insert the same view more than once into a sheet set, so having an exact 
duplicate allows for this to happen.  

  

Q14. How can I create a new wall sweep?"  
A14. You need to create a new family. To do that select from the pull-down 
menu, "File," "New," "Family." This will open the Imperial Templates folder. 
Select the template "profile.rft." Draw the new sweep shape using 2D lines. 
The two dashed lines in the template show you where the origin point is for 
the profile. Anything drawn to the right side of the vertical line will be 
inserted at and in front of the face of the wall. Anything drawn above the 
horizontal line will be inserted above the base of the wall. When you are 
done drawing, either select the "Load into project" button or save the profile 
to a folder if you may want to use it in another future project. If you just load 



it into the current project, the profile will be given the name "Family 1: 
Family 1." Now you can apply this new sweep to the wall as typical. 

  

Q15.  How can I change a curtain wall panel to a door or window? 
A15. First draw a curtain wall (it is one of the many wall types available). 
Then place at least one “Curtain Grid” in elevation or 3D view – Curtain 
Gridfs can be found under the modeling tab. Click on the grid and keep 
hitting the Tab key to highlight to the curtain wall panel you want to place a 
door or operable window into, and left mouse button it. It will then highlight 
(turn red). Select the Element Properties button (the one with the hand 
holding the page of text) and then under the Element Properties dialogue 
box, click the Load button and go to the Imperial Library and select any of 
the three Curtain Wall Doors available in the Doors folder or the Curtain 
Wall Awning window available under the Windows folder. Click OK and the 
panel will be replaced by the door or window loaded. They will not 
automatically be tagged as a door or window, but you can tag it later by 
selecting the Drafting pull-down menu or Drafting Design bar and selecting 
“Tag All Not Tagged.” 

  

Q16.  I cannot change a curtain wall panel to a door or window – I cannot 
even load curtain wall doors or windows; the “Load” button is greyed out. 
A16. One reason is that you have inadvertently set to curtain wall Curtain 
Panel construction to something other than “none.” To fix this, click on the 
badly behaving Curtain Wall, click the Element Properties button, click on 
the “Edit/New…” button, then pull down the list in the Curtain Panel line and 
select “none.” Click OK, then OK. Now you will be able to change individual 
panels to something else like curtain wall door or awning window or solid 
panels. Another possibility is that the curtain wall panel is "pinned." To fix 
this, just click on the pin that appears when you select the panel and it will 
"unpin" (the pin will now have a slash mark through it). 

  

Q17.  How can I copy and paste geometry from one file into another? 
A17.  Go to the file you want to copy from, highlight the objects to copy and 
type “Ctrl-C” (that is, hold down the Ctrl key and type “C”).  Then open the 
file you want to paste that element into and type “Ctrl-V.” 



 

Q18.  Revit Architecture 2010 dropped the link to the Autodesk Content 
Distribution Center. How can I get additional Revit Families for things like 
doors, windows, light fixtures, furniture, etc?  
A18.  You are still able to get to these useful families, but you will need to 
go directly to the web site http://revit.autodesk.com/library/html/ .  
 
I would recommend that when you get into the library, you pick the Revit 
Architecture 2009 Library, then US Library, then Families. If what you are 
looking for is not found there, you could select the “Archived Libraries” on 
this same page, of which there are three: 8.1, 9.0 and Architecture 2008. 
Most of these same Families were brought over to the Architecture 2009 
Library, however, with even more added.  
 
Another source for content is the new new “Autodesk Seek” web site which 
you can get to if you click on the Spy glass in the upper right portion of 
Revit, called “Content Search Online.” This takes you to a web site at 
http://seek.autodesk.com/?prodid=Revit:Architecture:2009:en  Note that 
there are very few Revit models in the Seek content yet, but eventually will 
be more. They are mostly AutoCAD drawings.  
 
A very good source for additional Families is Revit City: 
http://www.revitcity.com  Click on Join and join it (free) as a member so you 
can download the thousands of Family files that your colleagues have 
uploaded for your use.  
 
Reed Construction Data has embarked on an ambitious project to collect 
Revit Families in a large database called their "Smart BIM library" which 
they lease for about $500.00 per year. A free sample small database can 
be ordered through their website at 
http://www.reedconstructiondata.com/building-information-modeling/bim-
library/  

  

Q19. How can I put a footing under my foundation wall? 
A19. Simply select the structural menu and then select "Foundation>" and 
"Wall." Select the foundation wall you want to place a footing under and it 
will then draw a footing under the entire length of each wall segment you 
pick. The default Wall Foundation: Bearing Footing is 36" wide x 12" thick. 



If you want to change the dimensions, select one of the footings and select 
"Element Properties," then "Edit/New." Click "Duplicate." Give your new 
footing a new name. Then change the width and Foundation Thickness 
dimensions in the dialogue box. Click OK twice. You can select all of the 
other footings and apply the new footing type to them.  

  

Q20. I have drawn a topography for the site and it cuts right through the 
building. How can I cut a hole in the topography to show a basement in 
section? 
A20. Change your View to the Site plan. Select the Site menu, pick "Pad," 
then "Pad Properties," then select "Edit/New" then select the Edit button to 
the right of the Structure item in the Edit/New dialogue box. This will bring 
up the "Edit Assembly" dialogue box. Change the material to Gravel. There 
is no gravel material on the list. To create a gravel material, right-click on 
any of the materials in the list and select "Duplicate." Type in Gravel in the 
name slot. Give it a cut pattern by selecting the ... button to the right of the 
Cut Pattern pull down in the Materials dialogue box. Then pick the "New" 
button. Select the radio button Custom. Select the Import button. Browse 
for the AutoCAD pat file, which is at C:\Documents and 
Settings\AT150\Application Data\Autodesk\ACD-A 2009\enu\Support. Pick 
the Gravel.pat file. Change the "Import Scale" to 0.1. Click back on the 
word gravel in the dialogue box to set the import scale. Select OK three 
times. This will bring you back to the "Edit Assembly" dialogue box. Change 
the Material Thickness to 4". Click OK twice to come back to the "Element 
Properties" dialogue box. Change the Level to the Basement Level. 
Change the Height Offset from Level to -4" (this will place the gravel pad 
below the basement floor, which will be a 4" thick concrete slab). Select 
OK. Now you will be back to the Site Plan. Hover your cursor above one of 
the walls of the building and hit the tab key to select all walls, then left click. 
A magenta-colored line will be drawn around the walls. When you hovered 
your cursor over one of the walls in selecting the first wall, if you hovered it 
towards the outside of the wall, the magenta line will be drawn around the 
outside of the wall. This is where you want it to be. If you accidently 
hovered your cursor toward the inside face of the first wall, the magenta 
line will be drawn around the inside of the wall. To change it to the outside 
of the wall, simply pick the double "flip control" arrows that appears on the 
plan. Now it is on the outside. The reason you want to have it drawn on the 
outside of the wall rather than the inside, is that you want the gravel pad to 
define the hole in the earth as being cut on the outside of the foundation 



wall, not the inside, because if you place windows in the wall, you do not 
want the earth migrating into the window thickness. Note that topography is 
shown as a 10' thick earth pattern in section. The gravel pad will cross 
through the footing to the outside face of the foundation wall. To cover the 
gravel layer in section, draw a filled region around the footing and set its 
hatch pattern to concrete. The Filled Region command is under the Drafting 
menu. 

Normally you want the earth hatch pattern to be shown under the basement 
floor, as well as against the foundation wall. To change the thickness of the 
topography, select the "Settings" pull-down menu, then "Site Settings." This 
will bring up the Site Settings dialogue box. You can then change the 
"Elevation of poche base" to a dimension aboput 2 feet deeper than the 
deepest part of your basement.  

  

Q21. When I move one wall in plan several others move along with it. 
Why? 
A21. More than likely someone has locked a dimension line. To fix it, 
simply click on the dimension and select the lock to unlock it. 

  

Q22. Stairs in Revit do not look like they should. How can I fix them? 
A22. To turn off upward display of stairs: right click on stairs, select view 
properties, select "visibility graphics override" button. Expand "stairs" 
category, turn off both "stairs beyond cut line" and "stringers beyond cut 
line." To turn off upward display of railings: right click on one railing, select 
view properties, select "visibility graphics override" button. expand "railings" 
category, turn off "Railings Beyond Cut Line" and "stringers beyond cut 
line" 

  

Q23. Why do components downloaded from Revit City not show up in 
plan? 
A23. If a component downloaded from Revit City does not appear in the 
drawing, change the detail level on the View Control Bar at the bottom of 
the screen. Sometimes they only show up when detail level is set to "fine."  
You can edit the family to change the detail level in which they are shown - 



click on an object in the family and go to Visibility overrides in the instance 
parameter list. 

  

Q24. How can I show objects to be demolished as dashed? 
A24. How to show objects that are to be demolished as dashed lines in 
Revit: 
1.  Right-click in the view that you want to show demolition work in.  
2.  Click on the View Properties selection.  Under "Phasing" Category,  
    Phase Filter = Show Previous + Demo 
    Phase = "New Construction" 
3.  Your Demo view should start out with all objects drawn should be set to 
"Phase Created" = "Existing" Note that this will not be done by default. After 
you draw the base plan, select each object one at a time, click on the 
Element Properties button and change the "Phase Created" to "Existing." It 
is set to "New Construction" by default. Also for most objects, make "Phase 
Demolished" = none. 
4.  To show an object as demolished, click on object to highlight it, right 
click, select Element Properties, select "Phase Demolished" = "New 
Construction." 
5.  If you want to move an existing object to a new location in the New 
Construction phase, do the following: Open up the Demo view. Select the 
object to be moved, and set "Phase Demolished" = "New Construction." It 
will change to dashed lines, showing that it will be removed or moved. 
Copy it to a new location in that view. You will not see the copy because 
when you make a copy from the Demo view, Revit automatically sets the 
phase created to "New Construction" and Phase Demolished to "None." 
Switch to the New Construction view and you will see the copy. Move it to 
where you want it to go. 
6.  To make a new wall show up with a pattern and an existing wall show 
up without a pattern, do the following: Make sure that "Fine" Detail Level is 
set; open up the New Construction view, right click, select "View 
Properties," set Phase Filter to "Show Previous + New," Phase should be 
set to "New Construction." 

  

 

 



Q25. How can I show a surface pattern on a floor? 
A25. There are three ways to do this: 
 
1. You can attach a surface pattern to a floor in the definition of the floor 
material.  
 
2. You can add a different pattern to a floor by using the paint bucket. The 
surface material that is attached to the definition of the floor is called 
<default>. You will need to pick a different pattern in the paint bucket pull 
down and select the floor - be careful not to select a wall when you paint it, 
or the same pattern will be applied to the wall, and if you don't want it on 
the wall you will need to pick the wall again with the paint bucket and apply 
the <default> paint.  
 
Using methods 1 or 2 above, the entire surface of the floor will have the 
same pattern. If you want to paint just one or a few rooms, you will need to 
use the 3rd method, as follows: 

3. Create a floor type that is 1/4" thick with just one material having a 
surface pattern hatch, let's say a 4" square hatch to resemble tile, and 
place it in the room you want to have a pattern.Then select it and change 
its height to 1/4" above the floor level, That will hide the main floor pattern 
below. 
 
NOTE: In order for furniture, toilet fixtures or equipment to hide the floor 
pattern, you have to make sure that the visibility of the furniture, toilet 
fixtures or equipment family is turned on in the plan view. Wierdly, they are 
not, typically. It's a fooler. To fix this, open the family you want to hide the 
pattern behind, click on the top surfaces one at a time, and select the 
"Visibility... " button in the menu. This will bring up the "Family Element 
Visibility Settings" dialogue box. Check the "Plan/RCP" box under "View 
Specific Display" "Display in 3D views and:" and Detail levels "Coarse," 
"Medium," and "Fine." 

  

Q26. How can I print a drawing in Revit? 
A26. Printing in Revit: 
1. Start with 36" x 24"  bordered sheet 
2.  Select printer 
3.  Print Range: Current Window (unless you want to print several sheets - 



then pick "Selected Views/Sheets") 
4.  Click "Setup" button 
5.  Size: "Custom 1: 36 x 24 
6.  Zoom: 100% size 
7.  Paper Placement: Center 
8.  Orientation: Landscape 
9.  Click OK, then OK 
Note that if you do a Preview before you print, to get back to the print 
dialogue box, select the "Print" button.  The preview will not show the 
printed image correctly - it will be shifted down from the background, 
however, the entire sheet will be shown. 

  

Q27. What are the best View Range Settings for plans and reflected ceiling 
plans? 
A27.  
 
Plans: Cut Plane = 3'-9" (this allows for seeing receptacles above 3'-0" high 
countertops but will exclude switches); Top = Associated Level, offset 7'-6"; 
Bottom = Associated Level, offset 0'-0"; View Depth = Associated Level, 
offset 0'-0" 
NOTE: In plan, you will always be able to see 4'-0" below the associated 
level, if you have a change of plane equal or less than 4'-0". This allows for 
seeing to the bottom of dropped areas of floors, ramps or pits normally 
without having to change the View Depth. It may be an undesirable thing in 
soem cases, but it is built into the program and cannot be changed. 
 
Reflected Ceiling Plans: Cut Plane = 4'-0" (this allows for seeing switches, 
wall sconces and heads of doors); Top = Level Above; Bottom = (typically 
greyed out); View Depth = Level Above 

  

Q28. How can I show dimensions of less than 1 foot without showing the 0' 
preface? In other words, I want to have dimensions read 3 5/8" instead of 
the annoying 0'-3 5/8"? 

A28. Select from the tab "Manage" then "Project Units" then "Length" then 
check the box marked "Suppress 0 feet." Click OK and OK.  But you are 
not done yet - perversely, you also want Elevation Levels to read 0'-0" so to 
fix that, right-click on the Level Head in the Project Browser, it is under 



Families and then Annotation Symbols, Level Head - Circle. Select Edit. 
You will get a dialogue box that appears that says "Open "Level Head - 
Circle" for editing?" Answer "Yes." The family editor will then open. Select 
the word Elevation. Right click and select Element Properties. Pick Edit 
after the parameter Label. Select the word Elevation under the column 
Parameter Name. Select the # sign held by a ghostly hand at the bottom of 
the table. Turn off the check box that says "Use Project Settings" at the top 
and make sure that "Suppress 0 feet" is unchecked (it is unchecked by 
default). Select OK three times. Select "Load into Project" at the top of the 
screen, and then agree to override parameters.  

 

Q29. I purged the drawing and accidently purged out some railing styles 
that I need. How do I get them back 

A29. Open the file that does not have the railing styles you need. Now open 
a new drawing file. Select from the tab "Manage" then "Transfer Project 
Standards." The "Select Items to Copy" dialogue box will appear with a 
long list of "items" to select to copy to the current file from the other file. I 
would keep them all  checked and click "OK." If given a choice on which of 
the standards to transfer, select the "New Only" button. 


